
 

 

  

 Libra S6 

 User Manual 
English 

Deutsch 

Français 

Español 

Italiano 
 



  
  

Declaration of Conformity 
 

This is to certify that the Libra S6 and S6H Visible Spectrophotometers 
 Part number 80-5000-10 and 80-5000-11 
 
 Serial number 88000 onwards 
 
manufactured by Biochrom Ltd. conform to the requirements of the following 
Directives-: 73/23/EEC & 89/336/EEC 
 
Standards to which conformity is declared 
 
 EN 61 010-1: 2001 
 Safety requirements for electrical equipment for measurement, control and 

laboratory use. 
 
 EN 61326: 1998 
 Electrical equipment for measurement, control and laboratory use – EMC 

requirements 
 
Signed: Dated: 26th Oct 2004 
 

 
 
David Parr 
Managing Director 
Biochrom Ltd 
 
 
Postal address Telephone  Telefax 
 
Biochrom Ltd +44 1223 423723  +44 1223 420164 
22 Cambridge Science Park  
Milton Road e mail: enquiries@biochrom.co.uk website: http://www.biochrom.co.uk 
Cambridge CB4 0FJ 
England 
 
Registered in England No: 3526954  
Registered Office: 22 Cambridge Science Park, Milton Road, Cambridge CB4 0FJ, England. 

Biochrom Ltd 
Certificate No. 890333 



CONTENTS 
 

Unpacking, Positioning and Installation 1 
Essential Safety Notes 1 

OPERATION 2 
Introduction 2 
Using the Instrument 3 
Sample handling tips 4 
Absorbance and % Transmission 4 
Absorbance Ratio 5 
Cell Density 5 
Scan 6 
Factor Concentration 7 
Standard Curve 8 
Kinetics 10 
To recall a saved method 11 

SET UP 12 

ACCESSORIES 13 

ERROR MESSAGES 13 

OUTPUT OF RESULTS 13 
Use with serial printer 13 
Use with chart recorder 13 

USE WITH PC AND THE GRAFICO PC UTILITY 
SOFTWARE 14 

Installation 14 
Introduction 14 
Menu Descriptions 15 
Practical Aspects 16 

MAINTENANCE 17 
After Sales Support 17 
Lamp Replacement 17 
Cleaning and general care of the instrument 18 
Changing cell holder or removal for cleaning 18 
Changing the brightness of the display 18 

SPECIFICATION AND WARRANTY 19 
 

 



___________________________________________________________________ 
Issue 02 - 03/2005 Libra S6, English 1 

Unpacking, Positioning and Installation 
 
•  Inspect the instrument for any signs of damage caused in transit.  If any damage is 

discovered, inform your supplier immediately.  Check the position of the metal lamp 
bracket inside the lamp access area. 

•  Ensure your proposed installation site conforms to the environmental conditions for safe 
operation: 

Indoor use only 
Temperature 5°C to 35°C.  Note that if you use the instrument in a room subject to 
extremes of temperature change during the day, it may be necessary to recalibrate (by 
switching off and then on again) once thermal equilibrium has been established (2-3 
hours). 
Maximum relative humidity of 80 % up to 31°C decreasing linearly to 50 % at 40°C 

•  The instrument must be placed on a hard, flat bench or table that can take its weight (<2 
kg) such that air is allowed to circulate freely around the instrument. 

•  This equipment must be connected to the power supply with the power cord supplied.  It 
can be used on 90 - 240V supplies.   

• Switch on the instrument via the display after it has been plugged in.  The instrument 
performs a series of self-diagnostic checks for lamp performance, wavelength calibration 
and diode array pixels; press F2 to proceed. 

 
If the instrument has just been unpacked or has been stored in a cold environment, it should 
be allowed to come to thermal equilibrium for 2-3 hours in the laboratory before switching on 
to prevent calibration failure as a result of internal condensation. 
 

• The cell holder supplied with the instrument accepts standard 10mm pathlength glass or 
plastic cells (adapters are available to convert it to accept 10, 12 and 16mm diameter test 
tubes).  It can be removed for cleaning if spillages occur by undoing the screws that hold 
it or it can be flushed through with water in situ.   

• If the instrument has a heated cell holder option and it is on, allow 10 minutes for it to 
come to thermal equilibrium.  This cell holder cannot be removed. 

 
If this equipment is used in a manner not specified or in environmental conditions not 
appropriate for safe operation, the protection provided by the equipment may be impaired and 
instrument warranty withdrawn. 

Essential Safety Notes 
 
There are a number of warning labels and symbols on your instrument.  These are 
there to inform you where potential danger exists or particular caution is required.  
Before commencing installation, please take time to familiarise yourself with these 
symbols and their meaning. 
 

Caution (refer to accompanying documents). 
Background colour yellow, symbol and outline black. 
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OPERATION 

Introduction 
 
Your spectrophotometer is a simple-to-use, microprocessor controlled instrument.  It is a 
diode array product (1024 pixels), has no moving parts and scans very quickly. 
 
After switch on, calibration and pressing F2 to proceed the home page is shown offering the 
choice of  

• Repeat last operation 

• Make a measurement 

• Set up instrument 
 
“Repeat last operation” returns the user to the last screen displayed when the instrument was 
switched off, and provides a short cut to the last test that was performed. 
 
Within “Make a measurement” your spectrophotometer has facilities for: 

• measurement of absorbance, % transmission, ratio and concentration values 

• cell culture optical density measurements at 600nm 

• entry of a multi point standard curve in memory 

• output of wavelength scan to display  

• output of kinetics assay to display 

• application of a factor to an absorbance change over a specified time interval for an 
enzymatic determination (reaction rate) 

• storage of up to 99 user defined methods 
 
Within “Set up instrument” your spectrophotometer can be set up to  

• select the display language option (English, French, German, Spanish, Italian) 

• link via a serial lead to either a serial printer for hardcopy output or to a PC for 
download of results to spreadsheet  

• link via a converter lead to chart recorder 

• set the date for print outs 
 
The instrument is supplied with Grafico PC utility - on the accompanying CD - and a serial 
lead.  These provide the user with the means to capture, print and store data from the 
instrument to a PC.  Specifically it  

•  produces a printable graphical plot of the scan, in Abs 
•  logs date, time and serial number with any output from the instrument 
•  produces a results log in order to store, tabulate and subsequently print output from 

the instrument 
•  enables export of the output from the instrument to Excel as a text file 

A tutorial on UV/Visible spectrophotometry is included as part of the Grafico software. 
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Using the Instrument 
 
The back-lit liquid crystal display is very easy to navigate around using the function / select 
and arrow keys on the hard wearing, spill proof membrane keypad.   
 

 
 
Keypad  
F1, F2, F3, F4 The function select / entry soft keys on the keypad are situated next to 

the corresponding option on the display, and are used to select an 
appropriate mode 

3456 When a parameter within a mode needs selecting or changing (as 
indicated by highlighted text on the display), the four arrow keys 
(3456) are used in conjunction with the function keys to make that 
selection or change.  Use F4 to implement change, followed by 34 to 
choose between options indicated, and 56 to enter alphanumeric 
characters (for example in the selection of a wavelength or entry of a 
method title).  Then use F4 to accept the change made. 

 to escape or stop making measurements  
0A/100%T to set reference to 0.000AU or 100%T on a reference solution at the 

current wavelength in the mode selected, or to do a reference scan if in 
scan mode 

 to start making measurements 

  
Display The following symbols will appear in bottom right hand corner and mean 

the following: 
◊ Use 3456 to select option 
R T Ready to set reference or run sample 
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Sample handling tips 
 
•  Note that the light beam shines from LEFT to RIGHT through the cell chamber; 

ensure the cell is inserted in the correct alignment.   
•  The optical height is 15mm, and the minimum volume that can be used is 

approx. 700µl in a semi-micro cell. 
•  Align the indicator line on test tubes with the arrow on the cell compartment 

area to ensure reproducible positioning of the tube.  Note that test tubes do not 
last forever, and that the surface gets scratches and blemishes through repetitive 
use; if this is the case they should be replaced. 

 
Absorbance and % Transmission 
 
This makes simple absorbance measurements on samples, measuring the amount of 
light that has passed through a sample relative to a blank (this can be air).  The 
procedure is as follows: 
 
Option on display or action Press Comment 
Make a measurement F2  
Single / Multi λ  / Ratio F1  
Single λ  F1  
Abs / % T F1 Alternates between the two 
Set λ  F2, then 56 Select wavelength 
Accept λ F2  
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample  Value is displayed 

Repeat as necessary   
To exit     

 
To make up to 4 absorbance measurements on the same sample: 
 
Option on display or action Press Comment 
Make a measurement F2  
Single / Multi λ / Ratio F1  
Multi λ  F2  
Set λ’s F1, then 56 Select first wavelength 
Select λ F1, then 56 Select second wavelength  
Repeat as necessary   
All OK F4  
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample  Absorbance values are displayed 

Repeat as necessary   
To exit     
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Absorbance Ratio 
 
This makes simple absorbance ratio measurements on samples, measuring the 
amount of light that has passed through a sample relative to a blank (this can be air) 
at two wavelengths.  The procedure is as follows: 
 
Option on display or action Press Comment 
Make a measurement F2  
Single / Multi λ / Ratio F1  
Ratio  F3  
Remove this row   
Set λ1 F2, then 56 Select wavelength 
Accept λ F2  
Set λ1 F2, then 56 Select wavelength 
Accept λ F2  
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample  Ratio is displayed 

Repeat as necessary   
To exit     

 

Cell Density 
 
This function should be used to make an OD600nm reading on a cell culture rather 
than a direct absorbance reading as it compensates for turbidity using an auto-
correction at 800nm.  The absorbance at two wavelengths is measured 
simultaneously and an algorithm applied to compensate for the scattered light.  
Different instruments give different OD600 due to differences in the optical systems, 
so a conversion factor may be required for direct comparison.  We recommend the 
use of disposable cells rather than test tubes for this application. 
The procedure is as follows: 
 
Option on display or action Press Comment 
Make a measurement F2  
Cell Density  F2  
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample  Value is displayed; an auto-
correction factor is applied to the 
Absorbance value. 

Repeat as necessary   
To exit     
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 Scan 
 
An absorption spectrum can be obtained from your instrument, enabling simple 
identification of peak height and position.  The procedure is as follows: 
 
Option on display or action Press Comment 
Make a measurement F2  
Scan F4  
Abs / % T F1 Alternates between the two 
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample  Scan is displayed 

Repeat as necessary   
To identify peaks:   
Move cross hairs 34 Abs and λ values appear at top 
To zoom in on a region of 
interest: 

  

Zoom F2, then 
3456 

Move box that appears on display to area 
of interest 

Zoom in  F1 Examine detail 
Zoom out F1 Return to original data 
To exit     
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Factor Concentration 
 
Factor concentration mode is used when a conversion factor is known, and is 
required to convert the absorbance measurement for a sample at a specific 
wavelength into a concentration, by a simple multiplication of absorbance x factor. 
The procedure to define a new method is as follows: 
 
Option on display or action Press Comment 
Make a measurement F2  
Select a method F3  
 56 Select method number 
New F1 Name is highlighted 
Change Name F4, then 56 Enter first character of name 
 4, then 56 Enter second character of name 
 4, then 56 Repeat as necessary 
Accept  F4 λ is highlighted 
Change Wavelength F4, then 56  
Accept F4 Units is highlighted 
Select Units F4, then 56  
Accept  F4 Cal is highlighted 
Select Calibration option F4, then 34 Select Factor  
Enter Factor F4 then56  
. . . . F3 Moves decimal point 
Positive or negative? F2 Alternates between the two 
Accept F4  
Kinetics  Leave as no 
   
All OK F1 Accept method protocol 
Run method F1  
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample  Concentration is displayed 

Repeat as necessary   
To delete F3, then F1  
To exit     

 
Note:  It is not necessary to enter the name, and this can be omitted for a quick 
measurement. 
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Standard Curve 
 
The construction of a multi-point calibration curve from standards of known 
concentration in order to quantify unknown samples is a fundamental use of a 
spectrophotometer; this instrument has the advantage of being able to store this curve 
as a method, using up to 5 standards.   
 
To include a zero concentration standard, include this in the number of standards to 
be entered and enter 0.00 for concentration; use a blank when required to enter 
standard 
 
The procedure to define a new method is as follows: 
 
Option on display or action Press Comment 
Make a measurement F2  
Select a method F3  
 56 Select method number 
New F1 Name is highlighted 
Change Name F4, then 56 Enter first character of name 
 4, then 56 Enter second character of name 
 4, then 56 Repeat as necessary 
Accept  F4 λ is highlighted 
Change Wavelength F4, then 56  
Accept F4 Units is highlighted 
Select Units F4, then 56  
Accept  F4, 6 Cal is highlighted 
Select Calibration option F4, then 34 Select Std  
Accept F4 Goes to Calibration Curve page 
Set Std F1 1 is highlighted (maximum is 5) 
Change F1, then 56 Enter concentration of standard 1 
. . . . F3 Moves decimal point 
Accept F4 2 is highlighted 
Change F1, then 56 Enter concentration of standard 2 
. . . . F3 Moves decimal point 
  Repeat as necessary 
Incorrect entry? F3, then F1, 

56, F4 
Clears entry prior to re-entry 

Standards are all OK F4 Accept Concentrations 
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert Standard 1  Absorbance for Std 1 is measured 
Std 2 is highlighted 

Insert Standard 2  Absorbance for Std 2 is measured 
Std 3 is highlighted 

  Repeat as necessary 
Incorrect entry? F3, then F1, Clears entry prior to re-entry 
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56, F4 
All OK F4 Accept Standards 
Change Curve Fit algorithm F3, then 6, F4 Select linear least squares or 

polynomial curve 
View Graph F4  
Accept graph F3 Can now run samples 
   
To run samples   
All OK F1  
Run F1  
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample  Concentration is displayed 

Repeat as necessary   
To delete F3, then F1  
To exit     
To delete F2, then F1  
To exit     

 
Ensure Autoprint in set-up is set to off. 
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Kinetics 
 
Kinetics studies, where the change in absorbance needs to be followed as a function 
of time at a fixed wavelength, can be readily performed.  
 
Reagent test kits are routinely used for the enzymatic determination of compounds in 
food, beverage and clinical laboratories by measuring NAD / NADH conversion at 
340 nm.  The change in absorbance over a specified time period can be used to 
provide useful information when an appropriate factor, defined in the reagent kit 
protocol, is applied.  Reaction rate and enzyme activity can be calculated if the factor 
used takes account of the absorbance difference per unit time, as opposed to the 
absorbance difference per se.  
 
For this reason, the change in absorbance per minute (∆A/min), concentration 
(∆A/min x factor) and correlation coefficient (calculated from a best fit of the data 
points) are displayed.  They may not be relevant for simple kinetics experiments. 
 
The procedure to define a new method is as follows: 
 
Option on display or action Press Comment 
Make a measurement F2  
Select a method F3  
 56 Select method number 
New F1 Name is highlighted 
Change Name F4, then 56 Enter first character of name 
 4, then 56 Enter second character of name 
 4, then 56 Repeat as necessary 
Accept  F4 Wavelength is highlighted 
Change Wavelength F4, then 56  
Accept F4 Units is highlighted 
Enter Units F4, then 56  
Accept  F4 Cal is highlighted 
Select Calibration option F4, then 34 Select Factor  
Enter Factor F4 then 56 If required; this is used to convert 

∆A/min to Concentration 
. . . . F3 Moves decimal point 
Positive or negative? F2 Alternates between the two 
Accept F4  
Kinetics F4, then 34 Select Yes  or Fixed time * 
Accept F4 Start is highlighted 
Enter Start Time F4, then 

3456 
Usually 00m 00s, unless there is a lag 
time 

Accept F4 Interval is highlighted 
Enter time interval between 
each measurement 

F4, then 
3456 

Minimum interval is 10 seconds 
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Accept F4 End is highlighted 
Enter end time F4, then 

3456 
Maximum time is 59m 59s after 
completion of start time 
Maximum number of readings is 20, 
so maximum end time is 20 x the 
time interval 

Accept F4  
Run method F1  
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample  Abs values displayed for each time 
interval 
At end of run, calculated ∆A/min, 
correlation coefficient and 
concentration are displayed 

To view data   
Use Page Up and Page Dn F2 or F3  
To view graph F1  
    Return to values 
Repeat as necessary   
   
To exit     

 
*  The Fixed time option is for a single time measurement after a specified time, and 
therefore no options for start time, time interval and graphics are available. 
•  If the instrument is connected to a chart recorder the output is linearly fitted 

between data points as the software automatically interpolates these for the 
benefit of presentation.   

•  If you have a factory fitted electrical heated cell holder version of the 
instrument, go to Set-up to switch this facility on (37°C).  Allow 10 minutes for 
the instrument to come to thermal equilibrium. 

 

To recall a saved method 
 
Option on display or action Press Comment 
Make a measurement F2  
Select a method F3  
 56 Select method number 
Accept F4 Selected method is recalled 
Run method F1  
Insert reference 
RT on display 

0A/100%T Used for subsequent samples until 
changed 

Insert sample   
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SET UP 
 
Option on display or action Press Comment 
Set up instrument F3  
   
Set Language F1  
Select display language 56 English, French, German, 

Spanish, Italian 
Accept F1  
To exit     
   
Comms/Software Update F2, F1 Select Communications 
Select serial printer or PC F1 Alternates between them, with default 

settings for each option: 
Printer 1 is S1000P 
Printer 2 is Martell / Seiko DPU-414 
PC is for download to spreadsheet 
software and Grafico 

Set Baud of 9600 or 38400 F2 Use 9600 for Grafico and 38400 for 
download to spreadsheet software 

Auto-print F3 Use only if printer connected; select on 
for automatic increment of sample 
number and print out after measurement.  
Not recommended for standard curve. 
Do not use in PC mode as output is 
automatic anyway 

Accept  F4  
To exit     
   
Set Date / Time F3  
Select format F1 European or North American 
Enter values 3456 Enter as appropriate 
Accept F4  
To exit     
   
Heater control* F4 May not be available* 
Heated cell 34 Select on for thermostatting at 

37°C 
Accept  F4  
To exit     
   
 
*Heated cell holder factory fitted version only.  This option cannot be fitted 
retrospectively to an instrument. 
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ACCESSORIES 
 
PC serial cable (spare) 80-3001-00 
S1000P serial printer (includes serial printer cable) 80-3002-53 
Seiko DPU-414 printer 80-2108-80 
Serial cable for Seiko printer 80-2118-18 
Chart recorder interface cable 80-3003-55 
Test tube adapters (10, 12, 16mm) 80-2117-47 
 

ERROR MESSAGES 
 
After switch on, the instrument undergoes self-diagnostic tests for the tungsten lamp, 
wavelength calibration and diode array as part of its calibration procedure (  for 
OK, X for fail).  The results of this test are displayed and can be printed out or 
output to PC for filing and GLP (Good Laboratory Practice) purpose.  The messages 
for tungsten lamp and / wavelength calibration are self explanatory, involving 
checking that the cell compartment is clear or replacement of the tungsten lamp.  In 
the unlikely event of a diode array fail message contact your local supplier. 
 

OUTPUT OF RESULTS 

Use with serial printer 
Note that all results can be output to PC using the serial lead and Grafico software 
supplied on the user manuals CD.   
Seiko DPU-414 settings: 
Dip SW-1 Serial, Auto line feed off  
Dip SW-2 40 column width, International character set, USA 
Dip SW-3 Baud rate 9600 bps  
Note that the 80-2108-18 lead that is required will need two small nuts removing 
before connection. 
 

Use with chart recorder  
Kinetics results can be output to a chart recorder using the appropriate cable (80-
3003-55).  Voltage setting is 1V per 1 Absorbance unit (± 10 %) with an offset of 
1V = 0.000 Abs on the chart recorder; corresponding %T values are 1V per 100%T 
(± 10 %) with 0V = 0%T. 
To make the chart cable yourself, you require a female 9 way D type at one end with 
two (1 red, 1 black) 4mm banana plugs at the other (depending on the chart recorder) 
and 2 metres of coaxial cable or screened twin core, with the shield connecting the 
black plug and pin 5 and the core connecting the red plug and pin 1. 
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USE WITH PC AND THE GRAFICO PC UTILITY 
SOFTWARE 
 
Your instrument is supplied with a serial lead and Grafico software (on the user 
manuals CD) that enables it to be connected to a PC so that results can be captured, 
stored, printed and transferred into other applications easily.  In particular, a 
complete wavelength scan can be visualised on the PC and copied/pasted into a word 
document or powerpoint presentation.  An informative tutorial on aspects of 
UV/Visible Spectrophotometry is available as part of the software. 
 

Installation 
Prior to installation of Grafico, you should have the following options selected in your 
spectrophotometer instrument set up:  

PC / 9600 Baud / Autoprint off 
The software takes up approximately 0.5Mb of hard disk space when installed.  Proceed as 
follows to install the software: 
1. Place CD into the CD drive of the PC 
2. Use Windows explorer to locate the setup.exe file Grafico folder within the 

appropriately named instrument folder on the user manuals CD 
3. Double click on this so that the software installs, filling out the information as 

requested. 
4. The software can be started directly by Start > Programs > Grafico. 
 

Introduction 
•  When Grafico is selected, you are prompted to enter the file details (note that 

the title entered here is used as the title of the wavelength scan graph).  After 
pressing OK, the instrument (it should be already switched on and connected to 
the PC with the serial lead) is recognised by the software.   

•  There are two parts to the Grafico software, data-logging and scan.   
•  The default mode is data-logging; this receives instrument output from 

absorbance, %T, concentration and rate measurements (including time and date 
stamp). 

o Results can be copied from Grafico and pasted directly into Excel 
for ease of data transfer.  Alternatively results can be saved and 
opened up using Excel. 

•  If scan mode is selected (View > Scan mode), the full 330-800nm wavelength 
scan output from the instrument is shown (just press the run key as usual).  
Multiple peaks can be identified using a trace routine and labelled if required 
(by dragging the icon at the left side of the displayed graph and releasing at the 
appropriate point). 

o Graphs can be copied and pasted into Word, Excel or powerpoint 
o Graphs can be saved in a format that can be opened directly by 

Excel 
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Menu Descriptions 
 
File 
New Clears any existing data and starts a new report.  Prompts for file 

details (user name, organisation, title, descriptive text) 
Save / Save As Saves the data file in the file format selected.  The file details are 

included with this data 
Setup Displays a tabbed dialogue box so that automatic post process 

options for saving of graph, printing of graph and the graph scaling 
parameters can be defined.  The default data directory can be 
defined and is used for all save operations. 

Print Prints the entire file, including a header if defined in File>New 
Print Setup Runs the Common Print Dialog function to set up the printer 
Exit Closes the application 
 
Edit 
Copy Copies the data to clipboard for pasting into another application; in 

data-logging and scan modes this is text and graphic, respectively 
Clear Clears the data from the data set 
Select All Selects data and header together 
 
View 
Scan mode Switches between scan and data logging modes.  Successive scans 

overwrite existing scans on the display and can be saved if the 
autosave function is on 

File details Shows the file details entered at the start (or after File > New) and 
allows modification of these details, if required 

Autoscale Automatically sets the scale of the absorbance axis to optimise 
presentation (2.5, 2.0, 1.5, 1.0, 0.5, 0.2 or 0.1A) 

Set scale Sets the scale to user preference (Full, Auto, Define) 
Display grid Toggles on/off the grid on the graph (for presentation purposes) 
Toolbar View menu bar as icons 
Status bar View status bar at bottom of display 
 
Help 
Tutorial View tutorial on UV/Visible spectrophotometry 
Help topics View help topics 
About View version number etc 
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Practical Aspects 
 
Data logging mode  
•  When exporting rate mode results you can add the time in 10 second intervals to 

the spreadsheet manually (note that first data point is after 10 seconds, not zero 
seconds) and then graph the absorbance / time data (see scan mode – export to 
excel for more details).  

 
Scan mode 
•  Files can be saved as *.txt, *.csv (opens directly in Excel when double clicked) 

or *.wmf (picture) formats 
•  Label a peak by dragging and releasing the icon at the left side of the graph.  

The absorbance/wavelength details are shown in the title bar.  Dragging it again 
moves the label; moving it the left hand side takes the label away.  Multiple 
peaks can be added. 

•  Use display grid off for clearer presentation. 
•  Data can be output in absorbance only 
 
Scan mode – export to Excel and graphing 
•  If saving as a *.txt file, save the results to folder of choice. 

o Use Excel to open  this file; with files of type set to “all files” 
o Note that saving as a *.csv file and double clicking on it will open 

Excel directly 
•  Highlight the wavelength and absorbance values and click the graph icon 
•  Select chart type “XY Scatter” and the curved lines (no data points) option 
•  Label the axes etc as required  
•  Double click on the x-axis, select Scale and minimum to 330 and maximum to 

800 
•  Set colour scheme to suit your preferences 
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MAINTENANCE 

After Sales Support 
 
Support agreements that help you to fulfil the demands of regulatory guidelines 
concerning GLP/GMP are available. 
• Calibration, certification using filters traceable to international standards 
• Certificated engineers and calibrated test equipment 
• Approved to ISO 9001 standard 
 
Choice of agreement apart from break down coverage can include 
• Preventative maintenance 
• Certification 
 
When using calibration standard filters, insert such that the flat surface is facing 
away from the spring end of the cell holder 
 
Observe all necessary precautions if dealing with hazardous samples or solvents. 
 

Lamp Replacement 
 
A replacement lamp is available from your supplier using the following part 
numbers: 
 
Tungsten Lamp, S1000L 80-2115-33 
(use only this tungsten lamp as it is supplied with the connection wires; others will 
not operate correctly in this spectrophotometer) 
 
• The design of the lamp area is such that users are able to change their own 

lamps.  No lamp alignment is necessary as the lamp is pre-aligned. 
• The lamp becomes hot in use.  Ensure it is cool before changing it. 
• Do not touch the optical surfaces of the lamp with your fingers (use tissue); if 

touched, the area should be cleaned with iso-propanol. 
• Instructions for lamp change are provided with the lamp and overleaf. 
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To change the lamp, proceed as follows: 
 
1. Switch off the instrument, remove the sample from the cell holder and 

disconnect the power supply cord 
2. Remove the protective layers at the lamp access and plug in points on the 

underneath of the instrument 
3. Remove the lamp wires from the groove by gently unclipping it 
4. Remove the lamp by twisting the lamp assembly anti-clockwise  
5. Remove the lamp connection end by gently pulling with your fingers 
6. Replace with new lamp using the reverse of these actions 
 

Cleaning and general care of the instrument 
 
External cleaning 
Switch off the instrument and disconnect the power cord. 
Use a soft damp cloth. 
Clean all external surfaces. 
A mild liquid detergent may be used to remove stubborn marks. 
 

Changing cell holder or removal for cleaning 
 
•  Undo the screws that are visible on the top of the cell holder using a small flat 

headed screwdriver and lift the holder out by holding onto the projection; this may 
require pushing to the right as you do so in order to prevent fouling against the left 
side of the instrument cover.  If necessary, the cell holder can be helped out by 
pushing from the bottom of the instrument. 

•  Insert the test tube holder and secure in place using the same screws. 
•  Note that as well removal for cleaning, spillages in the cell holder can be flushed 

through using water from a squeeze bottle in order to prevent crystallisation / 
fermentation of residues. 

 

Changing the brightness of the display 
 
To change display brightness, proceed as follows: 
 
1. Ensure the instrument is on and that there is no sample in the cell holder 
2. Remove the protective layer at the lamp plug in point (underneath and at the rear 

of instrument) 
3. Place the instrument on its back, insert a small flat headed screwdriver into the 

potentiometer slot and turn it right or left until a suitable level of brightness is 
obtained. 
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SPECIFICATION AND WARRANTY 
Wavelength range 330 - 800 nm  
Monochromator Flat grating  
Wavelength calibration Automatic upon switch on 
Spectral bandwidth 7 nm 
Wavelength accuracy ±  2nm 
Wavelength reproducibility ± 1nm 
Light sources Pulsed Tungsten halogen  
Detector Diode array 
Photometric range - 0.300 to 2.500A, 0.3 to 199%T 
Photometric linearity ± 2.0 % or ± 0.010A to 1.000A at 546nm, whichever is 

the greater 
Photometric reproducibility < 0.002 A at 0A and 500nm 
Stray Light < 1%T 340nm according to ANSI/ASTM E387-72 
Stability ± 0.005A/h at 0A and 546nm after warm-up 
Noise ± 0.002A near 0A and ± 0.020A near 2A at 600nm 
Analogue output 1V per 1 Abs (±10%), 1V = 0A offset 

1V per 100%T (±10%), 0V = 0%T offset 
Digital output 9 pin serial  
Dimensions 180 x 270 x 390 mm 
Weight 1.75 kg 
Power input 90-265 V, 50/60 Hz, 15 VA 
  
Safety standard EN61010-1 
EMC emissions EN 61326-2.3 Generic emissions  
EMC immunity EN 61000-4-6 Generic immunity part 1 
Mains harmonics EN 61000-3-2 
Susceptibility standard IEC 801 
Quality System Designed and manufactured in accordance with an ISO 

9001 approved quality system 
British Design Registration No. 2097049 
 
Specifications are measured after the instrument has warmed up at a constant ambient 
temperature and are typical of a production unit.  As part of our policy of continuous 
development, we reserve the right to alter specifications without notice. 
 
Warranty 
Your supplier guarantees that the product supplied has been thoroughly tested to ensure that it 
meets its published specification.  The warranty included in the conditions of supply is valid 
for 12 months only if the product has been used according to the instructions supplied.  They 
can accept no liability for loss or damage, however caused, arising from the faulty or incorrect 
use of this product. 
This product has been designed and manufactured by Biochrom Ltd, 22 Cambridge Science 
Park, Milton Road, Cambridge CB4 0FJ, UK. 
 


